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Happy Summer Day!

Colorado Field Office Recognized for
Environmental Stewardship Excellence
By Deserai Anderson-Utley, EA

Lakewood- The U.S. Fish and Wildlife Service’s Lakewood ES field
office has been honored for their dedication to and participation in a
project that simultaneously protects the shortgrass prairie in Colorado
and helps plan for transportation needs in the state.  The field office is
the recipient of the Service’s first annual Transportation Environmental
Stewardship Excellence Award.

The project, implemented by the Service and the Colorado Department
of Transportation, works to protect the critical shortgrass prairie ecosys-
tem through easements and conservation agreements with private
landowners.  The shortgrass prairie provides habitat for many threat-
ened and endangered species in Colorado’s eastern plains.  This project
has helped to protect 36 species and 6 habitat types.  This initiative is
expected to protect as much as 50,000 acres of shortgrass prairie.
Species that benefit as a result of the project include the mountain
plover, black-tailed prairie dog, burrowing owl, and swift fox.

Lee Carlson, Lakewood office Field Supervisor, attended an awards
ceremony on Earth Day, April 22nd, in Washington, D.C. and was
presented with the award by Deputy Director Marshall Jones.  Deputy
Director Jones said, “Lee Carlson and his staff have made extraordinary
pro-active contributions to protect an endangered ecosystem, while
providing for critical transportation needs of the State of Colorado.”

In addition to the Service award, Carlson was presented with the 2003
Environmental Excellence Award in the Ecosystems Habitat and Wild-
life category from the Federal Highway Administration. The Lakewood
field office worked in partnership with 10 other Federal, State , local
and non-profit agencies to implement the Shortgrass Prairie Initiative.

(L to R): Marshall
Jones, Lee
Carlson and Paul
Hoffman

Congratulations to
Lee Carlson from
Region 6!
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2nd Annual Cultural Diversity Celebration
By Carrie Cordova, WTR

The Regional Office celebrated their 2nd Annual Cultural Diversity on
May 15, 2003.  Many employees wore ethnic clothes, prepared their
favorite ethnic food, shared items from travels abroad, and most impor-
tantly, brought themselves to participate in a fun-filled day of activities
and learning.

We also celebrated our Special Emphasis Programs.  Last year’s event
was so successful the Regional Office decided to offer it  again. In
previous years, the Office of Diversity and Civil Rights has been
responsible for organizing events to commemorate and celebrate Special
Emphasis Programs (SEP) recognized by Federal Executive Orders and
departmental policies.  The programs recognized include: Martin Luther
King’s birthday, National African American History Month, National
Women’s History Month, Women’s Equality Day, Asian/Pacific Ameri-
can Heritage Month, Older Americans Month, Gay and Lesbian Pride
Month, Hispanic Hertiage Month, National Disability Employment
Awareness Month, and Native American/Alaska Native Heritage Month.

Earlier this year, the Office of Diversity and Civil Rights requested
volunteers for the SEP commitee.  Members included Jolene Cervantes,
Nancy Braun, Michele Seitz, Carrie Cordova, Christy Bates, Gerri
Purvis, Mary Knuth, David Redhorse, Rick Estrada, Linda Stevens, and
Jeff Roets.  This committee had the responsibility of recruiting speakers
and entertainment for the program.

Ms. Denise Lopez, a senior from Westminster High School, kicked off
the event by singing a beautiful rendition of the National Anthem while
the Hickley JROTC presented the Colors.  Next, we heard from Mr.
Albert Smith, a Navajo Code Talker and World War II veteran.  Then,
Parents and Friends of Gay and Lesbian (PFLAG) shared personal
experiences and obstacles affecting our gay and lesbian communities.

This year employees of the Regional Office shared their ethnic dishes at
a potluck luncheon, while enjoying the uplifting music from the Har-
mony Gospel Group (featuring our own Gerri Purvis) that had us
clapping our hands and tapping our feet.  We also had booths with
information and items collected from our employees representing  the
fabric of our nation.  The booths were located in the third floor confer-
ence room where they were viewed throughout the entire day.

After lunch, we listened to a presentation from Special Olympics
Colorado, and learned that this organization is not only an athletic
organization but it also serves as a main social outlet for many disabled
Americans.  Next, Jeopardy’s Alex Trebec (Jeff Roets) and Wheel of
Fortune’s Vanna White (Carrie Cordova) stopped by for a fast-paced
game of Diversity Jeopardy where Lorene Trujillo went out on top
(literally considering she’s retiring this next month).  The last event of
the day was the Rocky Mountain Polynesian Dance Group who enter-
tained us with various dances from Hawaii, Tahiti and Polynesia.

The Special Emphasis Program Planning Committee would like to
extend thanks and appreciation to all employees who attended and
participated in this event.  We look forward to seeing you again next
year.  Also, remember we are always seeking ideas, suggestions, and
volunteers so please consider next year.  Once again, thank you for
supporting the program.

FWS Employee to
Receive White House
Award for Work in
“Greening” the Government
By Deserai Anderson-Utley, EA

Jim Behrmann is being recognized
for the third time for this initiative
and his creative work to bring
“greener” practices to the Fish and
Wildlife Service. Behrmann
received the White House Closing
the Circle Award for his commit-
ment to environmental steward-
ship on June 10, 2003, at a cer-
emony in Washington, D.C.

Nominated for his inventive uses
of environmental management and
procurement, Behrmann has lead
efforts in the regional office and at
field stations to use recycled
materials in building, mainte-
nance, and purchasing decisions.
He has used his position as
Environmental Compliance
Coordinator to promote the use of
environmentally friendly products
and increase recycling of materi-
als.  The award, which honors
Federal employees who demon-
strate leadership in helping
implement recycling, pollution
prevention, green procurement,
and other environmentally respon-
sible programs was designed to
foster support for green programs
nationwide.

Behrmann also received the
Service’s Environmental Leader-
ship Award and the Department of
the Interior Environmental
Achievement Award in 2002 for
his green procurement practices.
The White House Closing the
Circle Award winners were chosen
from over 200 nominations from
across the Federal Government.
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Media Corner
News Media: Bridging the
Interview
By Debbie Felker, Colorado River Info
and Education Coordinator

Sometimes when you are interviewed, you may be asked a question that
is unrelated to the topic being discussed or that steers you away from
the message YOU want delivered.  You can redirect the interview by
“bridging” the question. Bridging means answering or acknowledging
the interviewer’s question and then delivering your own positive
message.  Think of it in terms of your answer to their question plus the
message you want to give (A+1).

Here are examples of ways to “bridge” your response:

•  Your answer...and in addition I’d like to say...
•  Your answer...but the point I really want to make is...
•  No. Let me explain why.
•  Let me add something to that...
•  Another point I’d like to make is....

If a question is loaded or contains inaccurate information, challenge it
firmly and politely before you answer. You might say:

•  You have to look at it from a different perspective.
•  That’s not how I’d put it. What I would say is...
•  That’s not how we see it at the Fish and Wildlife Service.
•  That’s not really the issue, the issue is...

Colin Powell once said, “Remember that the reporter is in charge of the
question, but you are in charge of the answer.”

Next Month: Off-the-Record.

NWR Employee
Receives Highest
National Award
By Deserai Anderson-Utley, EA
With help from Jim Griffin
(National Elk Refuge)

Ann Blakely at the National Elk
Refuge is someone that other
administrative officers call for
help or advice.  She has been
recognized as the Jackson Hole
Business and Professional
Women’s Club, “Woman of the
Year”, and as Refuge Manager,
Barry Reiswig says, “Ann has
made many outstanding achieve-
ments in every aspect of her work
at the refuge.” This praise and
dedication earned Ann Blakely the
National Wildlife Refuge Em-
ployee of the Year Award for
2003.

Ann is the first administrative
officer to receive this prestigious
award.  She is known throughout
the U.S. Fish and Wildlife
Service’s Mountain-Prairie Region
as someone who can be counted
on to mentor and train other
administrative employees.  When
told of her selection, Blakley said,
“I am especially honored and
humbled by this selection, as I
enjoy working in an environment
where my skills and contributions
are recognized as vital to the
agency’s mission.”

Blakely was chosen to receive this
award from 5,000 employees at
over 450 refuges in the National
Wildlife Refuge System.  The
award ceremony was held in
Winston-Salem, North Carolina,
on March 26, 2003.  Ann’s 23 year
Federal service career includes
seven years with the National Park
Service, seven years with the U.S.
Department of Agriculture, and
nine years in her current position
with the Fish and Wildlife Service
at the National Elk Refuge in
Jackson, Wyoming.

The Refuge Employee of the Year
Award is given to an employee
who demonstrates a commitment
to conservation of our natural
resources, superior management
and/or technical skills, innovation,
effectiveness in dealing with
outside organizations and the
public, and whose work advances
the cause of wildlife conservation.

                                                            External Affairs is pleased to
                                                            announce that Sharon Rose, a
                                                             26-year veteran of the Service
                                                             and long-time cornerstone of
                                                            the R6 EA shop, has been
                                                            selected as the new Assistant
                                                            Regional Director for EA.
                                                            Sharon is no stranger to the ARD
role, having served as Acting ARD several times in the past, most
recently since January of this year, when Dan Sobieck returned to
Region 3.  Sharon’s institutional knowledge of, and dedication to the
Service and its programs will be a great asset for the Region, the bureau,
and fish and wildlife resources as we work to meet future challenges.
Please join us to welcome Sharon to her new “official” position!
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Bigtime Bust for Baiting Waterfowl
By Karen Miranda Gleason, EA

For the Yocams of Orchard, Colorado,
cattle ranching is a family business.
So, apparently, was baiting geese on the
family ranch near the eastern plains town
of Greeley. Father and son team David
and Matthew made quite a killing with their illegal hunting operation,
netting over $45,000 last year alone by leasing out blinds and charging
for access to baited areas, providing very successful hunting trips for
their clients.

“They used a front end loader to dump grain corn in short grass pas-
tures, immediately bringing in four to five thousand geese at a time,”
said Roger Gephart, Resident Agent in Charge and lead agent on the
case. “The birds were habituated to the area.”

The colorful duo often reserved the better shooting spots for themselves,
and their attorney and professional wrestler friends. Baiting birds wasn’t
their only illegal pastime.  Along with breaking game regs, the senior
Yocam was alleged to have been involved in violent activity for the last
15 to 20 years, including a felony conviction for illegal possession of a
machine gun.  His 25 year-old son is also a convicted felon.  Numerous
threats to individuals and conservation officers, a stash of guns, and
shoot-outs in connection with a family feud motivated neighbors into
keeping quiet about their actions.

After being tipped off to the activity by the Colorado Division of
Wildlife, law enforcement agents visited the ranch, knocked on the door,
and talked with the Yocams about waterfowl regulations.  The early
warnings were ignored.

Through numerous surveillances and interviews over the course of a
year, as well as analysis of hundreds of documents, agents were able to
document the crimes. Execution of a search warrant yielded ten illegal
firearms and 6,000 rounds of ammunition, along with receipts showing
the Yocams had bought, possessed, or sold other firearms and about
another 6,000 rounds of ammo.

Thanks primarily to the work of Regional Law Enforcement, the family
income and game harvest will now be dropping substantially, as the
Yocams enjoy a respite behind bars. With prosecution under Federal law
completed, David is now serving a one year and one day prison sen-
tence, while Matthew is scheduled for 5 months in prison and another 5
months of home confinement. Together, the pair will also fork over
$40,000 in fines for selling unlawfully taken wildlife, (hunting over
bait) and unlawful possession of firearms.

Region 6 Profiles
Big Game Big
 Draw at Sullys Hill

The Sullys Hill National Game
Preserve in Devils Lake, North
Dakota, was created in 1921 as a
big game preserve, refuge, and
breeding grounds for wild animals
and birds.  The 1,674-acre pre-
serve provides great opportunities
for 25,000 annual visitors to see
and photograph large game
animals.  This is one of four
Service preserves established
primarily to help in the recovery
of the American Bison. As a
Regional Conservation Learning
Center, it also provides more than
100 education programs to over
5,000 students every year.

Wildlife Abounds at
Lee Metcalf Refuge

No matter the time of year, your
chances of spotting wildlife are
pretty good at Lee Metcalf Na-
tional Wildlife Refuge. Since
1963, bald eagles, deer, and
waterfowl have called this 2,797-
acre area their home in the heart
of the Bitterroot Valley. A staff of
six tends to refuge programs and
the nearly 60,000 visitors which
tour the refuge annually. A self-
guided tour and many hiking trails
help visitors enjoy the wildlife and
the scenic landscape.  The refuge
also coordinates the Conservation
through the Arts Federal Junior
Duck Stamp Program.  A Kid’s
Fishing Clinic is offered during
National Fishing Week.
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Fish Technology Center Breaks Ground for New Lab
By Karen Miranda Gleason, EA

Despite biting cold, snow, rain, and wind, staff and supporters at the
Bozeman Fish Technology Center (FTC) were all smiles during the
much anticipated groundbreaking for the new $6.5 million lab and
administration building at the complex.  The new lab will provide better
tools and space for about 15 scientists and technicians tackling national
aquatic resource issues. The building will house new equipment,
laboratories, offices and conference rooms, a library, and a visitor’s
center with aquaria and historic displays.

The FTC is currently working on numerous efforts to support recovery
and restoration of threatened and imperiled species, and improve the
quality of recreational fish, including a partnership project studying
means to improve nutrition and reduce costs of feeding hatchery fish.
As part of its scientific work in fish nutrition, genetics, physiology,
microbiology and other areas, the Center analyzes biological samples
and exchanges information for studies to benefit pallid and shovelnose
sturgeon, cutthroat trout, Arctic grayling, razorback suckers, bull trout,
and rainbow trout.

Featured speaker at the groundbreaking was Bobbi Geise, Director of
Montana Outdoor Science School, who described the active partnership
with FTC to promote environmental education.  Other speakers included
Congressional staff for Montana Senators Burns and Baucus, and
Representative Rehberg; FTC Center Director Bill Krise and Assistant
Center Director Greg Kindschi; and Karen Miranda Gleason of External
Affairs, representing the Regional Office.

Construction for the new building began immediately and is expected to
be completed in a little over a year.  Ribbon-cutting and dedication of
the new facility is planned for August 2004.

Photo Caption: Breaking ground for construction of the new laboratory
and administration building at the Service’s Bozeman Fish Technology
Center in Montana. (L to R) Bobbi Geise, Director, Montana Outdoor
Science School; Laura Lloyd, field representative, Senator Burns; Jeff
Garrand, field representative for Rep.Rehberg; Clay Pipinich, Job
Foreman, Dick Anderson, Construction; Patti Bean, field representative
for Senator Baucus; Bill Krise, Center Director, Bozeman Fish Technol-
ogy Center.

Create Your Own
Custom Word Templates
by Heather Gonzalez, ITM

If you don’t like Arial font, you
never need to use it again, even
when writinig a new document in
Word version 2002. You can
create a template of your favorite
styles and sizes and use whenever
you want.

To create a custom template:

1. On the View menu, select Task
Pane.
2. If the New Document task pane
is not visible, select it from the
drop-down menu in the upper
right corner of the task pane.
3. In the New Document task
pane, click General Templates.
4. In the Template dialog box that
appears, select the General Tab,
and click Blank Document once to
select (it will be the base of your
new template).
5. Under the Create New section,
click Template, and then click OK.

In the new template, add any text
and graphics you want to appear
in all new documents that you
base on the template, and delete
any items you don’t want to
appear.

Make the changes you want to the
margin settings, page size and
orientation, styles, and other
formats.

On the File menu, click Save, give
your template a name, and then
click Close on the File menu.

Your new, customized template
will be available as a choice under
General Templates in the New
Document task pane.

Tip of the Month
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Native American Affairs
Director’s Remarks at Native
American Fish & Wildlife Soc.
By David Redhorse, EA

At the 2003 Native American Fish
and Wildlife Society national
conference held in Traverse City,
Michigan, Service Director Steve
Williams acknowledged progress
conserving and protecting wildlife
through partnerships developed
between tribes and the Service.
While he highlighted successful
program activities since the 1994
Native American Policy, he noted
early relations with one tribe
began in 1874, when the Service’s
predecessor worked with the
McCloud Wintu Tribe in the
Sacramento Valley to protect
traditional fishing while establish-
ing the nation’s first salmon
hatchery.

As he listed various achievements
in terms of funding, communica-
tion, government-to-government
relations, technical assistances,
training, and respect for Native
American religious and cultural
practices, the Director referenced
the 1994 Policy.  He mentioned
the contribution  of the Native
American Liaisons to improve
communication with tribes and
make Service expertise accessible
to tribes, the role of the Fish and
Wildlife Management Assistance
program to provide tribes techni-
cal assistance and supplement
tribal capabilities, the opportuni-
ties for fisheries management
under the recently completed
Fisheries Strategic Plan, habitat
restoration with Partners for Fish
and Wildlife, the training by the
Division of Law Enforcement and
preserving religious and cultural
practices by providing eagle
feathers and parts by the National
Eagle Repository and establishing
the eagle aviary at Zuni Pueblo.

With the new tribal wildlife
grants, the Director envisions
cooperative efforts to strengthen
the Native American Policy,
support conservation of fish and
wildlife resources on tribal lands,
and enhance the preservation of
tribal religious and cultural
traditions.The Mountain-Prairie Review is a  bi-monthly publication produced by the USFWS Region 6 External Affairs Office.  Publisher: Ralph Morgenweck,

Regional Director; Editor: Matt Kales,EA; Staff Writers: Karen Miranda Gleason,  Diane Katzenberger, David Redhorse, Sharon Rose ; Design and
Layout: Heather Gonzalez, IRM/ Jean Clemens, EA.  All contributions from Region 6 employees are welcomed and will be considered for publication.

Congressional Affairs
Legislative Affairs Update
By Matt Kales, EA

As the Independence Day Recess
nears, Congress is considering
several pieces of legislation of
interest to the Service:

New Bills
Newly introduced bills include S.
1307 (Smith, OR), which would
authorize the Secretary of Interior,
through the Bureau of Reclama-
tion, to assist in implementing fish
passage and screening facilities at
non-federal water projects in the
Columbia River Basin, which
includes portions of Montana,
Wyoming, and Utah. The bill,
which was introduced on June 20,
has been referred to the Commit-
tee on Energy and Natural Re-
sources (Domenici, NM).

Current Bill Status
On June 17, the Senate Environ-
ment and Public Works Subcom-
mittee on Fisheries, Wildlife, and
Water (Crapo, ID), held a hearing
on (S. 525 (Levin, MI), which
would amend the Nonindigenous
Aquatic Nuisance Prevention and
Control Act of 1990 to reauthorize
and improve the Act.  Key provi-
sions of the bill include a require-
ment for ecological surveys aimed
at early detection of invasive
species and an authorization for
$27.5 million in “rapid response”
funds.  The Department supports
reauthorization of the bill, but has
some concerns about some of the
technical amendments to the Act.
Deputy Director Matt Hogan
testified at the hearing and high-
lighted the Service’s history of
aggressively dealing with aquatic
invasives.

RD’s Column
The Changing Nature of
Western Water Managment
By Ralph Morgenweck, RD

On June 6, Secretary Norton
convened a conference in Denver
to announce “Water 2025,” a new
initiative aimed at preventing
future water conflicts between
competing interests in the West.
Water 2025 will help focus public
attention on those areas, such as
Denver and the Front Range,
where increasing demands on
water resources have created the
potential for “water wars” of the
sort we have seen recently in the
Klamath and Middle Rio Grande
River Basins.

Those of us that work with fish
and wildlife resources in the West
know how critical water is to
species and their habitats.  We also
know that unprecedented human
population growth and develop-
ment in this region, coupled with
agricultural water use, has placed
great strain on an already limited
water supply.  Everyday, we work
with cities, farmers, anglers,
power producers, elected officials,
and other water users to try and
accommodate human water needs
while ensuring that fish and
wildlife have water of sufficient
quantity and quality to persist.
Drought only makes our task more
difficult.

Fortunately, there are signs,
including Water 2025, that we as a
society are starting to recognize
the pressing need to develop a
new framework for water manage-
ment in the West.  This new
framework emphasizes conserva-
tion, acknowledges the finite
nature of supply in this dry
landscape, and most relevant to
the Service’s purview, recognizes
and provides for fish and wildlife.

Because this dominant existing
water management approach in
this part of the world is so firmly
rooted and codified, development
of this new framework is apt to be
slow and controversial.

Cont’ from RD’s Column
Our experience in trying to affect
change in the management of the
Missouri and Platte River Basin,
for example, illustrates this.  I am
confident, however, that by
continuing to promote and ad-
vance cooperative water manage-
ment practices that work for
people and for fish and wildlife, as
we have done in the Upper
Colorado River Basin, we will
eventually arrive at a sustainable,
long-term solution for Western
water issues.


